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1 PREFACE 

The Bruker Compass ReportDesigner 4.5 application (referred to as 'ReportDesigner') 
is the state-of-art Windows XP application for designing report layouts for printing 
reports with Bruker Daltonics programs. 

The ReportDesigner can be used to modify existing or to create own report layouts. A 
rich palette of graphical elements and dedicated, application specific components are 
available to be included in a layout, e.g., acquisition parameters or the chromatogram 
window. The ReportDesigner designs a layout by placing such components on a sheet. 
Layouts are used as a template when printing a report. A layout can only print graphics 
and results from one application. 
 
The ReportDesigner Reference Manual describes the menus and commands available 
in ReportDesigner 4.5 as well as the component properties that have to be defined in 
particular for the individual DataAnalysis-, QuantAnalysis-, flexAnalysis-, ProfileAnaly-
sis- and AuditTrailViewer-specific components.  
 
For reference on how to work with ReportDesigner 4.5, please refer to the Report-
Designer User Manual that is available as PDF document with your installation. 
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2 FILE MENU 

The File menu offers the following commands:  

  
Figure 2-1 File menu 

Command Used to… 

New Create a new layout. 
Open  Open the selected layout. 
Close  Close the active layout. 
Save  Save the active layout under the same file name. 
Save As  Save the active layout under another file name. 
Recent File List  Open the selected layout. 
Exit  Close ReportDesigner. 

2.1 New Command 

The New command is used to create a new layout. The command opens a new empty 
layout getting the name 'Report[running number]". You can change this name using the 
Save As command from the File menu. Once a new layout has been created, you can 
insert the components you want to be included in this layout and edit the layout to your 
needs. 

Shortcuts 

Button:   
Keys: Ctrl+N 
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2.2 Open Command 

The Open command is used to open an existing layout. The report layouts of an appli-
cation are stored in the corresponding “…\\Report Layouts\’application’” folder which 
may contain instrument-specific sub-folders. 
 
The command opens the Open dialog which allows you to specify the name and 
location of the layout file (*.layout) you want to open.  

  
Figure 2-2 Open dialog with a layout selected 

Look in and folder list 
Navigate to the folder that contains the layout you want to open. Double-click the layout 
or select it and click Open. 

File name 
Enter the name of the layout you want to open or select the layout from the folder list. 

Files of type 
Displays the type of files to be shown in the folder list. 

Report Files (*.layout). Lists *.layout files. 
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Open 
If a layout file is selected, it opens the respective layout and displays it contents in a 
new layout window. 
If a folder is selected, it opens the folder and displays its contents in the folder list. 

Shortcuts 

Button:   
Keys: Ctrl+O 

 

2.3 Close Command 

The Close command closes the active layout. If on closing a layout, its current pro-
cessing state has not been saved yet, a corresponding confirmation request for saving 
this state will appear. After answering this request, the respective layout is closed. 
 

2.4 Save Command 

The Save command saves the active layout under the same file name. If you want to 
save the layout under another file name, use the Save As command from the File 
menu. 

Shortcuts 

Button:   
Keys: Ctrl+S 

 

2.5 Save As command 

The Save As command is used to save the active layout under a new or already 
existing file name.  

Note: The layout must be saved to the folder that corresponds to the application the 
respective layout has been designed for. Otherwise, the layout will not be listed 
in the application's Print dialog. 

The command opens the Save As dialog, which allows you to specify the file name for 
the new layout file and the target folder. 
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Figure 2-3 Save As dialog 

Save in and folder list 
Navigate to the folder to which you want to save the layout.  

File name 
Enter a new file name or select an existing layout file from the folder list. 
 

Save as type 
Select the file format for saving the layout file: 

Report Files (*.layout). Saves to Report Files format. 
All Files (*.*). Lists all data files. 

Save 
If a new file name is entered, saves the layout under the specified file name in the 
chosen target folder.  
If an already existing file name is selected, a confirmation request appears, informing 
you that this file already exists and asks if you really wish to overwrite it. Clicking Yes 
results in the existing file being overwritten, clicking No allows you to enter a new file 
name. 



Bruker Daltonik GmbH File Menu 

ReportDesigner Reference Manual, Version 4.5  2-5

2.6 Recent File List 

You can use the numbers and layout file names listed in the recent file list at the 
bottom of the File menu to open quickly one of the last closed layouts. Select the 
number that corresponds to the layout file you want to open. 
 

2.7 Exit Command 

The Exit command closes ReportDesigner. If on closing ReportDesigner the current 
processing state of an open layout has not been saved yet, a corresponding confirma-
tion request for saving this state will appear. After answering this request, Report-
Designer is closed. 

Shortcuts 
Keys: ALT+F4 
Mouse: Click the application's . 

 -or- 
 Double-click the application's Control menu button. 

 



File Menu Bruker Daltonik GmbH 

 ReportDesigner Reference Manual, Version 4.5 2-6 

 



Bruker Daltonik GmbH Edit Menu 

ReportDesigner Reference Manual, Version 4.5  3-1

3 EDIT MENU 

The Edit menu offers the following commands:  

  

Figure 3-1 Edit menu 

Command Used to… 

Undo Undo the last action performed on the active layout. 
Redo  Redo the previously undone action performed on the active 

layout. 
Cut  Cut the selected component of the active layout and put it 

onto the Clipboard. 
Copy  Copy the selected component of the active layout and put it 

onto the Clipboard. 
Paste  Insert current Clipboard contents in the active layout. 
Delete  Delete the selected component from the active layout. 
Components  List all components currently defined for the active layout. 
Properties  Show and edits the properties of the selected component of 

the active layout. 
Default Properties  Define the default properties to be used to edit components 

of the active layout. 
Measurements and Size  Set the size of the canvas. 
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3.1 Undo Command 

The Undo command undoes the last action you have performed on the active layout.  

Shortcuts 

Button:   
Keys: Ctrl+Z 

 

3.2 Redo Command 

The Redo command redoes the action that has previously been undone for the active 
layout by using the Undo command from the Edit menu.  

Shortcuts 

Button:   
Keys: Ctrl+Y 

 

3.3 Cut Command 

The Cut command cuts the selected component and puts it on the clipboard. Using 
multiple selections, you can cut several components at once. Using the Paste com-
mand from the Edit menu, you can paste the cut out component(s) to a selected 
position on the canvas. 

Shortcuts 

Button:   
Keys: Ctrl+X 

 

3.4 Copy Command 

The Copy command copies the selected component and puts it on the clipboard. Using 
multiple selections, you can copy several components at once. Using the Paste com-
mand from the Edit menu, you can paste the copied component(s) to a selected 
position on the canvas. 

Shortcuts 
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Button:   
Keys: Ctrl+C 

 

3.5 Paste Command 

The Paste command pastes the current clipboard contents into the active layout. If you 
want to insert the component(s) at a specific position on the canvas, select the 
respective position by clicking with the left mouse button on it before you select the 
Paste command. If no position is specified, the component will be inserted at the upper 
left corner of the canvas. 

Shortcuts 

Button:   
Keys: Ctrl+V 

 

3.6 Delete Command 

The Delete command deletes the selected component from the active layout. Using 
multiple selections, you can delete several components at once. 

Shortcut 
Key: Del 
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3.7 Components Command 

The Components command is used to list all components currently defined in the 
active layout. The command opens the Components dialog, which lists the types of all 
components currently defined in the order of their inserting.  

  
Figure 3-2 Components dialog 
 

3.8 Properties Command 

The Properties command is used to show and edit the properties of the selected com-
ponent of the active layout. The command opens the tabbed Component Properties 
dialog with the tabs currently contained and the parameters currently available depend-
ing on the selected component. The following tabs may be present (ordered alphabetic-
ally): Font, Graphic, Iterator, Line, Position and Size, Properties, Selection, Table 
columns, Table style and Text. 
Shortcut 

Button:   
 
 
 
 
 
 
 
 
 
 



Bruker Daltonik GmbH Edit Menu 

ReportDesigner Reference Manual, Version 4.5  3-5

3.8.1 Properties Command - Font 

The Font tab is used to define for the selected component the font, font style and size 
to be used to print the text contained.  

  
Figure 3-3 Component Properties dialog - Font tab 

Font 
Select the font for the text to be printed. Default is 'Times New Roman'. 

Font style 
Select the font style for the text to be printed. Default is 'Regular'. 

Size 
Select the font size for the text to be printed. Default is '10'. 

Sample 
Displays a text sample according to the current parameter settings. 

Underline 
Check this option to underline the text to be printed. Default is unchecked. 

Strike-Out 
Check this option to draw a line through the text to be printed. Default is unchecked. 

Text Color 
Displays the color currently used to display the text to be printed. To select another 
color, click the drop-down button and select the desired color from the color palette. 
Default is 'black'. 
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3.8.2 Properties command - Graphic 

The Graphic tab is used to define for the selected component whether the height of the 
graphic to be printed should be adjusted to page height. 
 

 
Figure 3-4 Component Properties dialog - Graphic tab 

Adjust height to page height 
Check this option if the graphic’s height should be adjusted to page height, i.e. the gra-
phic will be stretched to the end of the page. 
 

3.8.3 Properties Command - Iterator 

The Iterator tab is used to define for the selected iterator component the number of 
columns and the gap width.  

Number of columns 
Enter the number of columns in which the members the iterator will iterate through 
should be printed. Default is '1'. 

Gap Width (pnts) 
Enter the gap width between the columns in points. Default is '1'. 
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Figure 3-5 Component Properties dialog - Iterator tab 

 

3.8.4 Properties Command - Line 

The Line tab is used to define for the selected generic Rectangle or Line component 
how lines should be drawn. 
 

  
Figure 3-6 Component Properties dialog - Line tab 
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Color 
Displays the color lines are currently drawn in. If you want to select another color, click 
the drop-down button and select the desired color from the color palette. Default is 
'black'. 

Transparent 
Check this option to display transparent lines. Default is unchecked. 

Style 
Select the style how lines should be drawn. Default is 'Solid'. 

Width 
Select the width of the line(s). Default is '1 Point'. 
 

3.8.5 Properties Command - Position and Size 

The Position and Size tab is used to view the current canvas position and size of the 
selected component. How the data is given depends on the current settings in the Size 
and Units tab of the Measurement and Size dialog. 

Note: The Position and size of a component cannot be changed via this tab.  

  
Figure 3-7 Component Properties dialog - Position and Size tab 

Left 
Displays the current position of the component relative to the left margin of the canvas.  
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Top 
Displays the current position of the component relative to the top margin of the canvas. 

Width 
Displays the current width of the component.  

Height 
Displays the current height of the component. 
 

3.8.6 Properties Command - Properties 

The Properties tab is used to define certain properties for the selected component. 
Depending on the selected component, different parameters will be available in this 
tab. For details, please refer to the description of the individual components in this 
manual. 
 

  
Figure 3-8 Component Properties dialog - Properties tab (example for a Chromato-

gram component) 

The parameters found in this tab are set by checking or unchecking boxes, entering 
values or selecting an option from the corresponding list. This is done as follows. 

• To check or uncheck a check box, click in the quadrate displayed next to the respec-
tive parameter. This will result in the corresponding check box being displayed. Then 
click in this box. 
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• To enter a new value for a parameter, click on the value currently displayed and 
enter the desired new value. 

• To select another option for a parameter, click on the option currently displayed. This 
will result in a list box appearing having a drop-down button. Click the drop-down 
button and select the desired option from the list. 

If the parameter name column is not large enough to display parameter names com-
pletely, you can broaden it by moving the column border to the right. For this, position 
the mouse cursor to the end of the parameter name field so that it changes to . Then 
drag the cursor with the left mouse button to the desired position.  
 

3.8.7 Properties Command - Selection 

The Selection tab of the Component Properties dialog is used to define for the 
selected component the element(s) whose corresponding data (name or value) is to be 
printed by this component.  

The elements listed in the Selection tab depend on the selected component e.g., ana-
lysis properties, acquisition parameters, method parameters. Depending on the 
respective component, selection of either a single or multiple elements is allowed. For 
details, please refer to the description of the individual components in this manual. 
 

  
Figure 3-9 Component Properties dialog - Selection tab (example for an Analysis Info 

component) 
 



Bruker Daltonik GmbH Edit Menu 

ReportDesigner Reference Manual, Version 4.5  3-11

Tree view 
Displays in tree view the parameters that can be selected for the selected component. 
If parameter selection needs an analysis to be selected, the parameters present 
depend on the selected analysis.  
Depending on the selected component, selection of a single or multiple parameters is 
allowed.  
To select a parameter, first expand (a) currently collapsed node(s) to display the para-
meter(s) contained. Then click in the check box that belongs to the parameter you want 
to select. This will mark the respective parameter and the folder it is contained in. If 
multiple selections are allowed, click on after the other in the check boxes of all para-
meters you are interested in. 

Name 
Check this option if the component should display the name of the selected parameter 
in the report when it is printed. 
Note: This parameter is not available for an Acquisition Parameter Table compo-

nent, because this component automatically prints the parameter's name and 
corresponding value. 

Value 
Check this option if the component should display the value that corresponds to the 
selected parameter in the report when it is printed. Default setting. 
Note: This parameter is not available for an Acquisition Parameter Table compo-

nent, because this component automatically prints the parameter's name and 
corresponding value. 

 

3.8.8 Properties Command - Table Columns 

The Table columns tab is used to define for the selected table component the 
columns to be contained. 

After a table component was inserted in a layout, its Table columns tab is empty. The 
columns to be printed by the respective component have to be selected from the corre-
sponding item list. The items in particular available depend on the selected component. 
For details, please refer to the description of the individual components in this manual. 
 
The Table columns tab lists all column items currently defined for the selected compo-
nent. The respective columns will be printed in the report appear according to the 
sequence specified in this list. You can add new items, delete items from this list, or 
change their sequence by using the following buttons. 
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Figure 3-10 Component Properties dialog - Table columns tab (example for a Mass 

List component) 

 
Opens an alphabetical list of all column items available for the selected component. To 
add a new item to the column list, click the desired item and then click in the column list 
field outside the selected item. This adds the selected item to the bottom of the current 
list. If desired, change the item's position in this list.  

 
Deletes the selected item from the table column list. 

 
Moves up the selected item by one line. 
Tip: You can also change an item's position by dragging it up or down with the left 

mouse button hold down. 

 
Moves down the selected item by one line. 
Tip: You can also change an item's position by dragging it up or down with the left 

mouse button hold down. 
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3.8.9 Properties Command - Table Style 

The Table style tab is used to define for the selected table component the column 
header style, item style and column space. 

  
Figure 3-11 Component Properties dialog - Table style tab 

Header Style 
Enter the column header size in points. Default is '10'.  

Underline 
Check this option if the column header should be underlined. Default is unchecked. 

Bold 
Check this option if the column header should be displayed in bold type. Default is 
unchecked. 

Item Style 
Enter the item size in points. Default is '8'. 

Column Space 
Enter the column space in points. Default is '10'. 
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3.8.10 Properties Command - Text 

The Text tab is used to define for the selected text component the text to be printed, 
the line layout and the horizontal and vertical alignment of text.  
 

  
Figure 3-12 Component Properties dialog - Text tab (for a generic Text component) 

Text 
Displays the text currently printed by the selected component. If you want another text 
to be printed with this component, overwrite the current text by the desired new text.  
When inserting a generic Text component in a layout, the default text is 'Text'. 

Multiple Lines 
Check this option if you want the text specified in Text to be written in multiple lines. 
Default is unchecked. 

Word Break 
When checking Multiple Lines, this option automatically becomes checked. If you 
uncheck it, this will result in the entered text not being broken down into multiple lines. 

Horizontal Alignment 
Defines how text should be aligned horizontally: 

Left. Aligns the text to the left of the component. 
Center. (Default) Aligns the text to the center of the component. 
Right. Aligns the text to the right of the component. 
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Vertical Alignment 
Defines how text should be aligned vertically: 

Top. Aligns the text to the top of the component. 
Middle. (Default) Aligns the text to the middle of the component. 
Bottom. Aligns the text to the bottom of the component. 

 

3.9 Default Properties Command 

The Default Properties command is used to define default properties to be used when 
inserting a component in the active layout. Which of the default properties will be 
applied depends on the component currently inserted.  

On selecting this command, the tabbed Default Properties dialog appears containing 
the Edit (opens by default), Labels, Line, Fill, and Font tabs. 
 

3.9.1 Default Properties Command - Edit 

Use the Edit tab of the Default Properties command to define the general and graphic 
editing properties to be applied when inserting a component in the active layout.  
 

  
Figure 3-13 Default Properties dialog - Edit tab 

In General Edit define general editing properties: 
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Allow Property Change 
Check this option to allow property change of the inserted component. Default is 
checked. 

Read Only 
Check this option if the inserted component must not be changed. When checking this 
option, all other options except for Allow Selection will automatically become disabled. 
Default is unchecked. 
 
In Graphic Edit define which type of editing is allowed: 

Allow Selection 
Check this option to allow selection of the inserted component. Default is checked. 

Allow Move 
Check this option to allow moving of the inserted component. Default is checked. 

Allow Rotation 
Check this option to allow rotation of the inserted component. Default is checked. 

Allow Vertex Editing 
Check this option to allow vertical editing of the inserted component. Default is 
checked. 
 

Allow Scaling 
Check this option to allow scaling of the inserted component. Scaling without Allow 
Stretch also being checked will result in the width and height of the component being 
enlarged or reduced simultaneously according to their relative sizes. Default is 
checked. 

Allow Stretch 
Check this option to allow stretching of the inserted component. This allows you to 
independently enlarge or reduce the width or height of the component. This option will 
only be enabled when Allow Scaling is checked. Default is checked. 

Allow Containment 
Check this option to allow containment of the inserted component. Default is 
unchecked. 
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3.9.2 Default Properties Command - Labels 

The Labels tab is currently not used.  
 

3.9.3 Default Properties Command - Line 

The Line tab of is used to define the default line drawing to be used when inserting a 
generic Rectangle or Line component in the active layout.  
 

  
Figure 3-14 Default Properties dialog - Line tab 

Color 
Displays the color currently used to draw lines. To select another color, click the drop-
down button and select it from the color palette. Default is 'black'. 

Transparent 
Check this option to display transparent lines. Default is unchecked. 

Style 
Select the style how lines should be drawn. Default is 'Solid'. 

Width 
Select the width of lines. Default is '1 Point'. 
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3.9.4 Default Properties Command - Fill 

The Fill tab is used to define the default component filling to be used when inserting a 
generic Text and Rectangle component in the active layout.  
 

  
Figure 3-15 Default Properties dialog – Fill tab 

Foreground Color 
Displays the color currently used to hatch a component according to the selected 
Hatch type. To select another foreground color, click the drop-down button and select 
the desired color from the color palette. 

Transparent Fill 
Check this option to perform transparent component fill. When checking this option, all 
other filling options available will automatically become disabled. 

Background Color 
Displays the color currently used for the component background. To select another 
background color, click the drop-down button and select the desired color from the 
color palette. The background will only be displayed in the selected color when Trans-
parent Background is not checked.  

Transparent Background 
Check this option to display a transparent background. When this option is checked the 
current Background Color setting will have no effect. 
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Hatch 
Select whether and how an inserted component should be hatched: 

No Hatch. Displays no hatch. 
Downward Diagonal. Displays a downward diagonal hatch. 
Crosshatch. Displays a crosshatch. 
Diagonal Crosshatch. Displays a diagonal crosshatch. 
Upward Diagonal. Displays an upward diagonal hatch. 
Horizontal. Displays a horizontal hatch. 
Vertical. Displays a vertical hatch. 

 

3.9.5 Default Properties Command - Font 

The Font tab is used to define the default font, font style and size to be used when a 
text printing component will be inserted in the active layout. These settings apply to all 
generic, Common, DataAnalysis, QuantAnalysis and flexAnalysis components that 
will print text. 
 

j  
Figure 3-16 Default Properties dialog – Font tab 

Font 
Select the font for the text to be printed. Default is 'Times New Roman'. 
Font style 
Select the font style for the text to be printed. Default is 'Regular'. 
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Size 
Select the size for the text to be printed. Default is '10'. 
Sample 
Displays a text sample according to the current parameter settings. 
Underline 
Check this option to underline the text to be printed. Default is unchecked. 
Strike-Out 
Check this option to draw a line through the text to be printed. Default is unchecked. 
Text Color 
Select the color the text is to be displayed in. To select another color, click the drop-
down button and select the desired color from the color palette. Default is 'black'. 
 

3.10 Measurements and Size Command 

The Measurements and Size command is used to define the size of the layout. On 
selecting this command, the tabbed Measurements and Size dialog appears contain-
ing the Size and Units (opens by default), Drawing Scale and Coordinate Mapping 
tabs. 
 

3.10.1 Measurements and Size Command - Size and Unit 

The Size and Units tab is used to set the size of the canvas of the active layout. The 
canvas must set to a size that is sufficient to place all components that should be 
included in the layout.  

Note: For printing a layout, its canvas size is of no importance. The canvas width will 
always be scaled to paper width when the layout is printed and the components 
will be printed with the same height as in the layout. 

Unit of Measure 
Select the unit of measure. If you want to use another unit than that currently selected, 
click the drop-down button and select the desired unit from the list. This will result in the 
current Canvas Width and Canvas Height being changed accordingly. Default is 
'Centimeters'. 
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Figure 3-17 Measurements and Size dialog - Size and Units tab 

Canvas Width 
Enter the desired canvas width according to the selected Unit of Measure. Default is 
'21'. 

Canvas Height 
Enter the desired canvas height according to the selected Unit of Measure. Default is 
'27.94’. 

OK 
Changes the canvas according to the currently specified size. If the Unit of Measure 
has been changed, the horizontal and vertical rulers of the layout window will be 
changed accordingly. 
 

3.10.2 Measurements and Size Command - Drawing Scale 

The Drawing Scale tab is currently not used.  
 

3.10.3 Measurements and Size Command - Coordinate 
Mapping 

The Coordinate Mapping tab is currently not used.  
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4 VIEW MENU 

The View menu offers the following commands:  

  
Figure 4-1 View menu  

Command Used to… 

Toolbar Show/Hide the toolbar. 
Status Bar  Show/Hide the status bar. 
Grid  Show/Hide the grid on the canvas of the active layout. 
Snap to Grid  Activate/Deactivate the Snap to Grid mode for the active layout. 
Angle Snap  - not yet implemented - 
Grid Properties  Set the grid properties for the canvas of the active layout. 
Zoom Normal  Zoom the visible canvas region of the active layout to normal scale 

(100 %). 
Zoom Percent  Zoom the visible canvas region of the active layout to a selected 

preset scale (50%, 75%, 100%, 200%). 
Zoom Custom  Zoom the visible canvas region of the active layout to a custom-set 

scale. 
Zoom to Fit  Zoom the visible canvas region of the active layout so that all 

components currently present in the layout will be displayed. 
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4.1 Toolbar Command 

The Toolbar command shows/hides the toolbar.  
 

4.2 Status Bar Command 

The Status Bar command shows/hides the status bar.  
 

4.3 Grid Command 

The Grid command shows/hides the grid on the canvas of the active layout. The grid is 
displayed according to the grid properties currently defined in the Grid Properties 
dialog. 

Shortcut 

Button:   
 

4.4 Snap to Grid Command 

The Snap to Grid command activates/deactivates the Snap to grid mode for the active 
layout. This mode can be active and will work even if the grid is currently not visible on 
the canvas. When this mode is active, component borders will automatically be 
anchored to grid points. This means, components can be inserted only to distinct 
places and can be moved or resized only by fixed steps that are defined by the current 
horizontal and vertical spaces of the grid. When this mode is not active, components 
can be placed to any position on the canvas and can be resized to any size.  

Shortcut 

Button:   
 

4.5 Angle Snap Command 

The Angle Snap command is not yet implemented. 
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4.6 Grid Properties Command 

The Grid Properties command is used to set the grid properties for the canvas of the 
active layout. The command opens the Grid Properties dialog, which allows you to 
define the grid properties. 

  

Figure 4-2 Grid Properties dialog 

Grid Visible 
Check this option to show the grid on the canvas. Uncheck this option to hide the grid. 

Snap to Grid 
Check this option to activate the Snap to Grid mode. Uncheck this option to deactivate 
this mode.  
When this mode is active, component borders will automatically be anchored to grid 
points when components are inserted, moved or sized. This means, components can 
be moved or resized only in fixed steps that are defined in Grid Spacing. When this 
mode is deactivated, components can be placed to any position on the canvas and can 
be resized to any size. 
This mode can be active even if the grid is hidden. 

Angle Snap 
This option is not yet implemented. 

Grid Color 
Shows the color the grid is currently displayed in. If you want to display the grid in 
another color, click on the arrow and select the desired color from the color palette.  
 
In Grid Spacing define the horizontal and vertical spaces between the grid points: 

Horizontal 
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Enter the horizontal space between two points of the grid. 

Vertical 
Enter the vertical space between two points of the grid. 
 

4.7 Zoom Normal Command 

The Zoom Normal command zooms the visible region of the canvas of the active 
layout to normal scale (100 %). This command is only enabled when the canvas of the 
active layout has been zoomed previously. 
 

4.8 Zoom Percent Command 

The Zoom Percent command zooms the visible region of the canvas of the active 
layout to a preset scale; either to 50%, 75%, 100% or 200%. On selecting this 
command, a magnification percent list pops up. Click on the desired percentage scale 
the visible region of the canvas is to be zoomed to. 
 

4.9 Zoom Custom Command 

The Zoom Custom command is used to zoom the visible region of the canvas of the 
active layout to a custom-set scale. The command opens the Zoom dialog, which 
allows you to enter a custom-set magnification or to select a preset magnification from 
the list by which the canvas should be zoomed. 

  
Figure 4-3 Zoom dialog 

Magnification 
Displays the current magnification of the visible canvas region. To change the current 
magnification, select a preset percentage from this list or enter a desired zoom value. 
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OK 
Zooms the visible region of the canvas to the specified scale. 
 

4.10 Zoom to Fit Command 

The Zoom to Fit command zooms the visible region of the canvas of the active layout 
so that all components currently present in this layout will be displayed.  

Shortcut 

Button:   
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5 WINDOW MENU 

The Window menu offers the following commands:  

  
Figure 5-1 Window menu 

Command Used to… 

New Open an additional layout window for the active layout. 
Cascade  Arrange multiple layout windows in cascade view. 
Tile  Arrange multiple layout windows in tile view. 
Arrange Icons  Arrange the icons of layouts, which have been minimized. 
Open Layout List  Activate the selected layout and display its window on top. 
 

5.1 New Window Command 

The New Window command opens an additional layout window for the currently active 
layout.  
 

5.2 Cascade Command 

The Cascade command arranges all open layout windows which are currently not 
minimized in cascade view. Each window has the same default size but is shifted by 
title bar height and an angle of 45°. The active layout displays on top and is indicated 
by its title bar being highlighted.  
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Figure 5-2 Two layout windows arranged in cascade view 

 

5.3 Tile Command 

The Tile command arranges all open layout windows which are currently not minimized 
in tile view. In tile view, the windows are arranged as non-overlapping tiles. The current 
width and height of the layout windows are resized. The width is adjusted according to 
the current ReportDesigner window width. The height is adjusted according to the 
current height of the ReportDesigner window and the number of layout windows to be 
arranged with each of them getting the same height. The active layout is indicated by 
its title bar being highlighted.  
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Figure 5-3 Two layout windows arranged in tile view 
 

5.4 Arrange Icons Command 

The Arrange Icons command arranges the icons of layouts whose corresponding win-
dows are currently minimized within a straight line at the bottom of the ReportDesigner 
window. 

    
Figure 5-4 Before (left) and after (right) arranging icons  
 

5.5 Open Layout List 

Use the open layout list if more than one layout is open at a time to activate a layout, 
which is currently not active. The currently active layout is indicated by a check mark in 
front of the layout name. Selecting another layout from this list activates that layout and 
shows its layout window according to the currently active display mode. If you select a 
layout currently minimized this will result in the respective layout window being shown 
again either maximized or on top of the other multiple layout windows.  
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6 HELP MENU 

The Help menu offers the following commands:  

  
Figure 6-1 Help menu 

Command Used to… 

Help Topics  Start ReportDesigner Help. 
Operator Log in the specified operator. 
Lock All Applications Lock ReportDesigner and all other Bruker Dalton-

ics applications. 
About Compass ReportDesigner  Provide information about your present Report-

Designer copy. 
 

6.1 Help Topics Command 

The Help Topics command starts ReportDesigner Help in order to get information 
about specific topics. ReportDesigner Help is used as other help applications running 
under Windows. 

Shortcut 
Key: F1 

 

6.2 Operator Command 

The Operator command is used to change the operator during a running Report-
Designer session. When ReportDesigner is running in Compliance mode, you can also 
use this command to change your current password.  

Note: There is always only one operator logged into Bruker Daltonics applications on 
a specific computer at a time. 
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The command opens the ReportDesigner dialog, which allows you to log in and/or 
change your password. Depending on the current mode, Non-Compliance or Compli-
ance, this dialog looks something different. In Non-Compliance mode, you can log in 
without identifying whereas in Compliance mode you have to identify by operator name 
and password. 
Note: This dialog appears automatically on each start-up of your ReportDesigner 

application unless you are currently logged in another Bruker Daltonics applica-
tion (for both Non-Compliance and Compliance mode) or the corresponding 
option for skipping this dialog is set (for Non-Compliance mode only).  

 

 
Figure 6-2 ReportDesigner dialog for logging in the operator when in Non-Com-

pliance mode  

 
Figure 6-3 ReportDesigner dialog for logging in the operator when in Compliance 

mode 
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Operator 
Enter your operator ID. The ID of the current operator will automatically be entered if 
the UserManagement administrator has set the corresponding option. The operator ID 
is not case-sensitive. 

Password 
Enter your password. The password is not displayed as you type it. 
Note: Passwords are case-sensitive. Successive wrong inputs will cause locking of 

the operator when the number of wrong login tries exceeds the number of 
wrong logins allowed by the UserManagement administrator. Only the 
UserManagement administrator can unlock a locked operator. 

Note: This entry field is available in Compliance mode only. 

Always log in using this operator 
Check this option if the operator named in Operator should be logged in automatically. 
This will skip this dialog when starting ReportDesigner in future. 
Note: This check box is available in Non-Compliance mode only. 

Change Password 
Allows you to change your current password before logging in. Opens the Change 
Password dialog (see below). 
Note: This button is available in Compliance mode only. 

Log On 
Logs in the (specified) operator.  
In Compliance mode, log in will be successful only if operator ID and password match. 
If both do not match an error message will appear. Successive wrong password inputs 
can cause locking of an operator by UserManagement. If a new created operator tries 
to log into a Bruker Daltonics application the first time, the program requires for chang-
ing the password. Quitting the request opens the Change Password dialog (see 
below). 
 

Change Password dialog 
This dialog is used to change the current password for the operator named in Ope-
rator. The new password must comply with the password policy settings defined by the 
UserManagement administrator. 

Operator 
Displays the ID of the operator whose password can be changed. If the password for 
another operator should be changed, click Cancel and enter the desired operator in the 
previous dialog. 
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Figure 6-4 Change Password dialog 

Old password 
Enter your current password. The password is not displayed as you type it. 
Note: Passwords are case-sensitive. 

New password 
Enter the new password.  
Note: Passwords are case-sensitive. Make sure, that the new password complies with 

the current password policy settings. 

Confirm new password 
Confirm your new password. You must enter the same password as above. 

OK 
If the new password and its repetition are the same and the new password complies 
with the current password policy settings, it changes the password. A dialog informs 
you about successful password change. Quitting this dialog returns you to the Report-
Designer dialog.  
If the new password and its repetition are different or the chosen password does not 
comply with the current password policy settings, a corresponding message appears. 
Quit the message and in the Change Password dialog make again desired entries. 
If the old password is incorrect, a message about denying password change appears. 
Quitting this message returns you to the ReportDesigner dialog. 
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Figure 6-5 Messages on successful password change (left) and chosen password is 

violating password policy (right) 
 

6.3 Lock All Applications Command 

Note: The Lock All Applications command is available only in Compliance mode. 

The Lock All Applications command locks all Bruker Daltonics applications. This 
includes ReportDesigner as well as all other Bruker Daltonics applications currently 
installed on your system.  

Note: Only the previous operator or someone with the special right to unlock applica-
tions can unlock a locked application.  

Note: Automatic locking of all UserManagement using Bruker Daltonics applications 
will occur if one of these applications has not been used for a certain period 
defined by the UserManagement administrator. 

 
The command opens the ReportDesigner dialog which informs you that Report-
Designer has been locked, by whom (displays the full name of the operator) and how it 
can be unlocked. Do the required entries to unlock the application. 

Operator 
Enter the operator ID of the operator who has locked ReportDesigner. The respective 
operator ID will automatically be entered if the UserManagement administrator has set 
the corresponding option. 
If not the previous operator but someone else wants to unlock the applications, enter 
the respective operator ID. 
Note: This respective operator must have the right to unlock applications. 

Password 
Enter the corresponding password. 
Note: Passwords are case-sensitive. Successive wrong password inputs will cause 

locking of the operator. 
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ReportDesigner dialog when ReportDesigner has been locked 

Change Password 
Allows you to change your current password before logging in. Opens the Change 
Password dialog. 

Log On 
If operator ID and password match, and the respective operator is allowed to unlock 
applications, it unlocks Bruker Daltonics applications and logs in the specified operator. 
 

Shortcut 
Key: Ctrl+Alt+K 

 

6.4 About Compass ReportDesigner Command 

The About Compass ReportDesigner command is used to display the version num-
ber of your present copy of ReportDesigner with the copyright notice, the user-specific 
license information as well as how to contact Bruker Daltonik GmbH. The command 
opens the About Bruker Daltonics ReportDesigner dialog. 
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Figure 6-6 About Bruker Daltonics ReportDesigner dialog 

Shortcut 

Button:   
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7 DATAANALYSIS-SPECIFIC FEATURES 
When DataAnalysis is installed on your system, ReportDesigner provides specific 
features to design layouts for printing reports with DataAnalysis. The DataAnalysis 
Components toolbar contains buttons for inserting DataAnalysis components in the 
layout. It is shown when ReportDesigner was started without opening a specified layout 
or when a DataAnalysis layout is active. The DataAnalysis menu is shown in the menu 
bar; its Select Analysis command is used to load an analysis needed to define specific 
properties of acquisition parameter printing components. ReportDesigner provides the 
following DataAnalysis-specific components for printing reports with DataAnalysis. 

  

Analysis Info  
Analysis Description  
Acquisition Parameter  
Acquisition Parameter Table  
LC Acquisition Parameter  
Sample Info 
Method Part  
Display  
Analyses Iterator  
Density View 
Chromatograms Iterator  
Chromatogram  
Compounds Iterator  
Compound Name  
Compound List  
Spectra Iterator  
Work List Iterator 
Spectrum  
Mass List  
Deconvolution Results  
SmartFormula Table 
Calibration Info  
Script Table  
Scripting Variable  
Signer Table  
Signer List  
Application Name 

Figure 7-1   DataAnalysis Components toolbar 
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7.1 Analysis Info Component 

The Analysis Info component prints one element from the analysis information of an 
analysis. A layout can contain several Analysis Info components, each of them 
printing different analysis information. 

Type: Text 

Button:   

Specific component properties to be defined 
The element to be printed is selected in the Selection tab of the component's Compo-
nent Properties dialog. This displays the various items of analysis information that can 
be selected. Only a single element is allowed to be selected by checking its corre-
sponding box. Either the Name or the Value (default) of the element can be printed. 

  
Figure 7-2 Selection tab: Selection of one element for an Analysis Info component 
 

7.2 Analysis Description Component 

The Analysis Description component prints the analysis description of an analysis. 

Type: Multi Line Text 

Button:  
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7.3 Acquisition Parameter Component 

The Acquisition Parameter component prints one item from the acquisition parame-
ters of an analysis. 

Type: Text 

Button:  
 
Selection of acquisition parameters requires an analysis to be selected for the active 
layout. An appropriate analysis can be loaded using the Select Analysis command 
from the DataAnalysis menu.  
Note: When an Acquisition Parameter component is selected and the Properties 

command from the Edit menu is chosen but currently no analysis is loaded for 
the active layout, the Open Analysis dialog will automatically be opened to 
select an analysis.  

Specific component properties to be defined 
The element to be printed is selected in the Selection tab of the component's Compo-
nent Properties dialog. This tab displays a selectable subset of all acquisition parame-
ters of the analysis currently loaded. Only one single element is allowed to be selected 
by checking the corresponding box. Either the Name or Value (default) of the element 
can be printed. 
 

  
Figure 7-3 Selection tab: Selection of one element for an Acquisition Parameter 

component 
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7.4 Acquisition Parameter Table Component 

The Acquisition Parameter Table component prints a table of acquisition parameters 
of an analysis. This table contains the parameter names and corresponding values. 

Type: Table 

Button:  

Selection of acquisition parameters requires an analysis to be selected for the active 
layout. An appropriate analysis can be loaded using the Select Analysis command 
from the DataAnalysis menu.  
Note: When an Acquisition Parameter Table component is selected and the Pro-

perties command from the Edit menu is chosen but currently no analysis is 
loaded for the active layout, the Open Analysis dialog will automatically be 
opened to select an analysis. 

Specific component properties to be defined 
By setting the Show N/A Parameter option in the Properties tab of the component's 
Component Properties dialog you can define whether all selected or only the applic-
able parameters are to be printed in the report. This option allows you to use the same 
report layout for different instrument configurations (e.g. different ion sources). If this 
option is not checked, only the applicable parameters that are relevant for the respect-
tive analysis will be printed in the report. If this option is checked, not applicable 
parameters will also be printed getting the value 'n/a'. 

  
Figure 7-4 Properties tab for an Acquisition Parameter Table component (default 

setting) 
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The parameters to be printed are selected in the corresponding Selection tab. This tab 
displays a selectable subset of all acquisition parameters of the currently loaded analy-
sis. Multiple selections of elements are allowed. You can select all elements of interest 
by checking the corresponding boxes. 

How the table should look like is set in the corresponding Table style tab. 

  
Figure 7-5 Selection tab: Selection of multiple elements for an Acquisition Parameter 

Table component 
 

7.5 LC Acquisition Parameter Component 

The LC Acquisition Parameter component prints LC acquisition parameters of an 
analysis. The LC acquisition program enters the parameters that correspond to the 
different components of the LC system into the respective analysis folder.  

Type: Multi Line Text 

Button:   

Specific component properties to be defined 
The LC acquisition parameters to be printed are selected in the Table columns tab of 
the component's Component Properties dialog. This tab lists all columns currently 
defined for the component. For a newly inserted component, the column list will be 
empty.  
To add a column to this list, click  and select the desired item from the appearing 
list. Repeat adding for all columns you want to have in the report. Use  and  to 
change the columns' sequence in the list and, therefore, in the report. Click  to 
delete a column from this list. 
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Figure 7-6 Table columns tab: Selection of columns for a LC Acquisition Parameter 

component 

  
Figure 7-7 List of LC acquisition parameter items available 
 

7.6 Sample Info Component 

The Sample Info component prints specific data of the HyStar sample info of the 
selected analysis.  

Type: Table 

Button:   

Specific component properties to be defined 
The data to be printed is defined in the Properties tab of the component's Component 
Properties dialog. 
The Sample Info can be printed (default) as well as the Sample Table Header and 
User Defined Data. 
How the table should look like is set in the corresponding Table style tab. 
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Figure 7-8 Properties tab for a Sample Info component (default setting) 
 

7.7 Method Part Component 

The Method Part component prints the DataAnalysis method part of the selected 
analysis. 

Type: Text 

Button:   
 

7.8 Display Component 

The Display component prints the current DataAnalysis window. 

Type: Graphic  

Button:  

Specific component properties to be defined 
The data window(s) to be printed and the data to be displayed are defined in the Prop-
erties tab of the component's Component Properties dialog. 
The Display parameter sets the data to be printed. If Selected Analysis is selected 
only the data of the selected analysis will be printed. If All Analyses is selected the 
data of all open analyses that are currently not hidden or disabled will be printed. 
The Line Width parameter sets the line width in points to be used to print the graphic. 
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The Active Window Only option sets if all open data windows or only the currently 
active one is to be printed. If this option is not checked, all open data windows will be 
printed. If this option is checked, only the currently active data window will be printed. 
The Include Chromatogram Legend options sets if a chromatogram legend is added 
to the report. 

Whether the height of the graphic should be adjusted to page height is defined in the 
corresponding Graphic tab. 

  
Figure 7-9 Properties tab for a Display component (default setting) 
 

7.9 Analyses Iterator Component 

The Analyses Iterator component iterates through analyses currently open in Data-
Analysis. All layout components that are placed inside an Analyses Iterator compo-
nent will be applied to the analysis that is iterated. Therefore, with one layout several 
analyses can be printed at a time.  

Type: Iterator 

Button:  

Specific component properties to be defined 
Which analyses are to be iterated is set in the in the Properties tab of the component's 
Component Properties dialog. 
The Analyses parameter sets if the iterator will iterate through All analyses or Only 
Enabled analyses. In addition, the All Selected Analyses option sets if only the 
selected analyses or all analyses in the chosen group (All or Only Enabled analyses) 
will be iterated. 
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How the data to be printed should be arranged in the printout is defined in the corre-
sponding Iterator tab. 
 

 
Figure 7-10 Properties tab for an Analyses Iterator component (default setting) 
 

7.10 Density View Component 

The Density View component prints the Density View of an analysis. 

Type: Graphic  

Button:   

Specific component properties to be defined 
The retention time range to be printed are set in the Properties tab of the component's 
Component Properties dialog.  
The Line Width parameter sets the line width in points to be used to print the graphic. 
By Start Time [min] and End Time [min] the retention time range to be printed is set. 
If both are zero, the entire view will be printed. 
Whether the height of the graphic should be adjusted to page height is defined in the 
corresponding Graphic tab. 
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Figure 7-11 Properties tab for a Density View component (default setting) 
 

7.11 Chromatograms Iterator Component 

The Chromatograms Iterator component iterates through all chromatograms of an 
analysis. All layout components that are placed inside a Chromatograms Iterator 
component will be applied to the chromatogram that is iterated. Therefore, with one 
layout several chromatograms can be printed at a time. 

Type: Iterator 

Button:  

Specific component properties to be defined 
Which chromatograms are to be iterated is set in the in the Properties tab of the com-
ponent's Component Properties dialog. 
The All Selected Chromatograms option sets if chromatograms of different analyses 
or only of the selected analysis are to be iterated. If this option is checked all currently 
selected chromatograms will be iterated. If this option is unchecked only the chromato-
grams of the selected analysis will be iterated. 
The Enabled Chromatograms Only option sets if only enabled or all chromatograms 
are to be iterated. If this option is checked, only enabled chromatograms will be 
iterated. If it is unchecked, disabled chromatograms will be iterated as well. 

How the data to be printed should be arranged in the printout is defined in the corre-
sponding Iterator tab. 
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Figure 7-12 Properties tab for a Chromatograms Iterator component (default setting) 
 

7.12 Chromatogram Component 

The Chromatogram component prints one or more chromatograms of an analysis.  

Type: Graphic 

Button:  

Specific component properties to be defined 
The chromatogram(s) and retention time range to be printed are set in the Properties 
tab of the component's Component Properties dialog.  
The Line Width parameter sets the line width in points to be used to print the graphic. 
The Print parameter sets the chromatograms to be printed. If Single Chrom. is 
selected only a single chromatogram will be printed. If Multiple Chrom. is selected all 
chromatograms of an analysis will be printed.  
Note: The Single Chrom. option will only work within a chromatogram iterator. 
By Start Time [min] and End Time [min] the retention time range to be printed is set. 
If both are zero, the total chromatogram will be printed. 
The Include Legend option sets whether or not a legend is to be drawn below the 
chromatogram(s). If unchecked, no legend will be drawn. 

Whether the height of the graphic should be adjusted to page height is defined in the 
corresponding Graphic tab. 
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Figure 7-13 Properties tab for a Chromatogram component (default setting) 
 

7.13 Compounds Iterator Component 

The Compounds Iterator component iterates through all compounds of an analysis. 
All layout components that are placed inside a Compounds Iterator component will be 
applied to the compound that is iterated. Therefore, with one layout several compounds 
can be printed at a time. 
Type: Iterator 

Button:  

Specific component properties to be defined 
Which compounds are to be iterated is set in the in the Properties tab of the 
component's Component Properties dialog. 
The All Selected Compounds option sets if compounds of different analyses or only 
of the selected analysis are to be iterated. If this option is checked, all currently 
selected compounds will be iterated. If this option is unchecked, only the compounds of 
the selected analysis will be iterated. 
The Enabled Compounds Only option sets if only enabled or all compounds are to be 
iterated. If this option is checked, only enabled compounds will be iterated. If it is 
unchecked, disabled compounds will be iterated as well. 

How the data to be printed should be arranged in the printout is defined in the Iterator 
tab of the component’s Component Properties dialog. 
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Figure 7-14 Properties tab for a Compounds Iterator component (default setting) 
 

7.14 Compound Name Component 

The Compound Name component prints the name of the current compound.  
Note: This component will only work within a Compounds Iterator component. 
Type: Text 

Button:  
 

7.15 Compound List Component 

The Compound List component prints a Compound List of an analysis.  
Type: Table 

Button:  

Specific component properties to be defined 
Whether the columns to be printed should be taken over from DataAnalysis or are to be 
defined in ReportDesigner is set in the Properties tab of the component's Component 
Properties dialog. If Get layout from DataAnalysis is checked, that Compound List 
layout will be used that is currently defined for the respective analysis in DataAnalysis 
when printing of the report is started. 
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Figure 7-15 Properties tab for a Compound List component (default setting) 

If Get layout from DataAnalysis is not checked, the columns to be printed have to be 
defined in the corresponding Table columns tab. This tab lists all columns currently 
defined for the component. For a newly inserted component, the column list will be 
empty. To add a column to this list, click  and select the desired item from the 
appearing list (same as for DataAnalysis Compound List layout). Repeat adding for all 
columns you want to have in the report. Use  and  to change the columns' 
sequence in the list and, therefore, in the report. Click  to delete a column from this 
list. 

How the table should look like is set in the corresponding Table style tab. 
 

  
Figure 7-16 Table columns tab: Selection of columns for a Compound List component 

whose columns should not be taken over from DataAnalysis 
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Figure 7-17 List of Compound List items 
available (same as for Data-
Analysis Compound List lay-
out) 

 

 

7.16 Spectra Iterator Component 

The Spectra Iterator component iterates through spectra. All layout components that 
are placed inside a Spectra Iterator component will be applied to the spectrum that is 
iterated. Therefore, with one layout several spectra can be printed at a time. Which 
spectra are iterated depends on the context. Within a compound iterator, the spectra of 
the respective compound will be iterated. Outside of a compound iterator, the spectra 
of a single mass spectrum analysis will be iterated. 
Type: Iterator 

Button:    

Specific component properties to be defined 
Which mass spectra are to be iterated is set in the in the Properties tab of the compo-
nent's Component Properties dialog. 
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Figure 7-18 Properties tab for a Spectra Iterator component (default setting) 

The All Selected Spectra option sets if mass spectra of different analyses or only of 
the selected analysis are to be iterated. If this option is checked, all currently selected 
spectra will be iterated. If this option is unchecked, only the spectra of the selected 
analysis will be iterated. 
The Only Enabled Spectra option sets if only enabled or all spectra are to be iterated. 
If this option is checked, only enabled spectra will be iterated. If it is unchecked, dis-
abled spectra will be iterated as well. 
The Spectra Type parameter sets the type of mass spectra to be iterated. If All is 
selected the iterator will iterate through all spectra, i.e. top level and child spectra. If 
Top Level Spectra is selected only top level spectra will be iterated but no child 
spectra. If Library Spectra is selected the iterator will iterate only through library spec-
tra. This applies to spectra from a mass spectral library or to spectra that have child 
spectra from a library. 

How the data to be printed should be arranged in the printout is defined in the Iterator 
tab of the component’s Component Properties dialog. 

7.17 Work List Iterator Component 

The Work List Iterator component iterates through the spectra in the Work List if a 
Spectrum component is placed inside it. 

Type: Iterator 

Button:   

Specific component properties to be defined 
How the data to be printed should be arranged in the printout is defined in the Iterator 
tab of the component’s Component Properties dialog. 
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7.18 Spectrum Component 

The Spectrum component prints one or more spectra. 

Type: Graphic 

Button:  

Specific component properties to be defined 
The spectrum/spectra and mass range to be printed are set in the Properties tab of 
the component's Component Properties dialog.  
The Line Width parameter sets the line width in points to be used to print the graphic. 
The Print parameter sets, which spectrum/spectra is/are to be printed. If Multiple 
Spectra is selected, all spectra of an analysis will be printed. If Single Spectrum is 
selected, only a single spectrum will be printed.  
Note: The Single Spectrum option will work only within a Chromatogram Iterator 

component. 
By Start Mass and End Mass the mass range to be printed is set. If both are zero, the 
entire spectrum will be printed. 
The Include Legend option sets whether or not a legend is to be drawn below the 
mass spectrum/spectra. If unchecked, no legend will be drawn. 
Whether the height of the graphic should be adjusted to page height is defined in the 
corresponding Graphic tab. 

  
Figure 7-19 Properties tab for a Spectrum component (default setting) 
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7.19 Mass List Component 

The Mass List component prints a Mass List of a mass spectrum.  
Type: Table 

Button:  

Specific component properties to be defined 
Which peaks should be included in the Mass List and which columns are to be printed 
is defined in the Properties tab of the component's Component Properties dialog. 
The Get layout from DataAnalysis option sets whether the columns to be printed 
should be taken over from DataAnalysis or be defined in ReportDesigner. If this option 
is checked, that Mass List Layout will be used that is currently defined for the respect-
tive analysis in DataAnalysis when printing of the report is started. 
The Number of Peaks parameter sets, which peaks are to be listed in the printed 
Mass List. If All is selected all peaks contained in the current Mass List of the mass 
spectrum will be printed. If Most intense is selected, only the most intense peaks of 
the current Mass List will be printed. In this case, the number of peaks to be included 
has to be specified in # Most Intense Peaks. 
 

  
Figure 7-20 Properties tab for a Mass List component (default setting) 

If Get layout from DataAnalysis is not checked, the columns to be printed have to be 
defined in the corresponding Table columns tab. This tab lists all columns currently 
defined for the component. For a newly inserted component, the column list will be 
empty.  
To add a column to this list, click  and select the desired item from the appearing list 
(same as for DataAnalysis Mass List layout). Repeat adding for all columns you want to 
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have in the report. Use  and  to change the columns' sequence in the list and, 
therefore, in the report. Click  to delete a column from this list. 

How the table should look like is set in the corresponding Table style tab. 

  
Figure 7-21 Table columns tab: Selection of table columns for a Mass List component 

when columns should not be taken over from DataAnalysis 

  
Figure 7-22 List of Mass List items available (same as for DataAnalysis Mass List lay-

out) 
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7.20 Deconvolution Results Component 

The Deconvolution Results component prints the deconvolution results of a mass 
spectrum.  

Type: Text 

Button:  

Specific component properties to be defined 
Which deconvolution results are to be printed is set in the Properties tab of the compo-
nent's Component Properties dialog. The Show Detailed Results option sets 
whether or not detailed results are to be printed. If this option is checked, details will be 
printed for each deconvolution component found. If it is unchecked, only a summary 
table will be printed.  

  
Figure 7-23 Properties tab for a Deconvolution Results component (default setting) 
 

7.21 SmartFormula Table Component 

The SmartFormula Table component prints SmartFformula results of a mass 
spectrum.  

Type: Table 

Button:   

Specific component properties to be defined 
Which columns are to be printed is defined in the Properties tab of the component's 
Component Properties dialog. The Get layout from DataAnalysis option sets 
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whether the columns to be printed should be taken over from DataAnalysis or be 
defined in ReportDesigner. If this option is checked, that SmartFormula List Layout will 
be used that is currently defined for the respective analysis in DataAnalysis when 
printing of the report is started.  

  
Figure 7-24 Properties tab for a SmartFormula Table component (default setting) 
 
If Get layout from DataAnalysis is not checked, the columns to be printed have to be 
defined in the corresponding Table columns tab. This tab lists all columns currently 
defined for the component. For a newly inserted component, the column list will be 
empty.  
To add a column to this list, click  and select the desired item from the appearing list 
(same as for DataAnalysis SmartFormula List layout). Repeat adding for all columns 
you want to have in the report. Use  and  to change the columns' sequence in 
the list and, therefore, in the report. Click  to delete a column from this list. 

  
Figure 7-25 Table columns tab: Selection of table columns for a SmartFormula Table 

component when columns should not be taken over from DataAnalysis 
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Figure 7-26 List of SmartFormula List items available (same as for DataAnalysis 

SmartFormula List layout) 
 

7.22 Calibration Info Component 

The Calibration Info component prints the calibration status data of the selected 
analysis that is shown in DataAnalysis in the Properties - Calibration Status dialog. 

Type: Text 

Button:   
 

7.23 Scripting Table Component 

The Scripting Table component prints a table containing values of a variable of an 
analysis that have been saved via the automation ScriptVariable property. 

Type: Table 

Button:   
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Specific component properties to be defined 
The columns to be printed are selected in the Properties tab of the component's Com-
ponent Properties dialog. In Variable Name enter the name that has been specified 
in automation for the ScriptVariable property. 

How the table should look like is set in the corresponding Table style tab. 

 
Figure 7-27 Properties tab for a Scripting Table component 
 

7.24 Scripting Variable Component 

The Scripting Variable component prints a variable of an analysis that has been 
saved via the automation ScriptVariable property. 
Type: Text 

Button:   

Specific component properties to be defined 
Which variable is to be printed is set in the in the Properties tab of the component's 
Component Properties dialog. In Variable Name enter the name that has been speci-
fied in automation for the ScriptVariable property. 
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Figure 7-28 Properties tab for a Scripting Variable component (default setting) 
 

7.25 Signer Table Component 

The Signer Table component prints detailed signing information.  

Type: Table 

Button:   

Specific component properties to be defined 
The columns to be printed are selected in the Table columns tab of the component's 
Component Properties dialog. This tab lists all columns currently defined for the 
component. For a newly inserted component, the column list will be empty.  
To add a column to this list, click  and select the desired item from the appearing list 
(same as for DataAnalysis Compound List layout). Repeat adding for all columns you 
want to have in the report. Use  and  to change the columns' sequence in the list 
and, therefore, in the report. Click  to delete a column from this list. 

How the table should look like is set in the corresponding Table style tab. 
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Figure 7-29 Table columns tab: Selection of columns for a Signer Table component 

 
Figure 7-30 List of Signer Table items available 
 

7.26 Signer List Component 

The Signer List component prints the names of all signers in succession. It is intended 
for placing signing information into the header or footer. 

Type: Text 

Button:   
 

7.27 Application Name Component 

The Application Name component prints the application name and version number. 
For example, for Bruker Compass applications ‘Bruker Compass’ is placed in front e.g. 
‘Bruker Compass DataAnalysis 4.0’. 

Type: Text 

Button:   
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7.28 DataAnalysis Menu and Select Analysis Com-
mand 

The Select Analysis command from the DataAnalysis meu is used to load the analy-
sis you want to use to select the acquisition parameter(s) for an Acquisition Parame-
ter or Acquisition Parameter Table component. 

 
Figure 7-31 DataAnalysis menu 

Selecting this command opens the Open Analysis dialog, which allows you to select 
the analysis whose acquisition parameters you want to see in the Selection tab of the 
Component Properties dialog. 
 

Look in 
Click the drive or folder that contains the analysis you want to load.  

Folder list 
Displays the folders or the files of the format currently selected in Analysis of type that 
are contained in the drive or folder selected in Look in.  
Double-click the folder that contains the analysis you want to load, and perhaps further 
sub-folders, until the desired analysis file appears. Double-click the analysis file or 
select it and click Open.  

File name 
Enter the name of the analysis file you want to load or select it from the folder list. 
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Figure 7-32 Open Analysis dialog 

Analysis of type 
Select the type of analysis files to be shown in the folder list. 

All Analyses. Lists analyses of all formats. 
NT Analyses (*.d). (Default) Lists all analyses of the *.d format. 
Esquire OS/2 Analyses (*.anl;*.msf;*.scs). Lists all analyses of the *.anl, *.msf or 

*.scs formats. 
MM1 Analyses (*.mmd). Lists all analyses of the *.mmd format. 
XMass Analyses (*.ser;fid). Lists all analyses of the *.ser and fid formats. 
netCDF Analyses (*.cdf). Lists all analyses of the *.cdf format. 
All (*.*). Lists all files available. 

Open 
If an analysis file is selected, it loads the respective analysis. This results in the corre-
sponding acquisition parameters being listed in the Selection tab of the Component 
Properties dialog when this is opened for an Acquisition Parameter or Acquisition 
Parameter Table component. 
If a folder is selected, it opens the folder and displays its contents in the folder list. 
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7.29 Saving Folder for DataAnalysis Layouts 

DataAnalysis layouts must be saved to the folder "C:\BDALSystemData\Report 
Layouts\DataAnalysis". Only layouts that are contained in the DataAnalysis folder will 
be listed in DataAnalysis' Print dialog.  
Depending on the current installation, the DataAnalysis folder contains (an) instrument-
specific sub-folder(s), e.g. "…\\DataAnalysis\Esquire" in which you can save your 
layouts. In addition, you can create own sub-folders. When saved to such a sub-folder, 
a layout will be listed in the DataAnalysis Print dialog with the sub-folder name 
followed by the layout name e.g., ‘Esquire\Chromatogram Report’. 
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8 QUANTANALYSIS-SPECIFIC FEATURES 

When QuantAnalysis is installed on your system, ReportDesigner provides specific 
features to design layouts for printing reports with QuantAnalysis. The QuantAnalysis 
Components toolbar contains buttons for inserting QuantAnalysis components; this 
toolbar is only shown when ReportDesigner has been started without opening a 
specified layout or a QuantAnalysis layout is active. The QuantAnalysis menu is 
shown in the menu bar: its Select Analysis command is used to load an analysis 
needed to define specific properties of acquisition parameter printing components. 

ReportDesigner provides the following QuantAnalysis-specific components for printing 
reports with QuantAnalysis:  

  

Batch Info  
Acquisition Parameter Table  
LC Acquisition Parameter  
Method Parameter  
Method Table  
Work Table  
Analyses Iterator  
Analysis Name  
Analysis Info  
Chromatogram  
Spectrum  
Compounds Iterator  
Compound Name  
Compound List  
Calibration Blocks Iterator  
Calibration Curve  
Calibration Block Number  
Audit Trail  
Signer Table  
Signer List  
Application Name  

 

Figure 8-1 QuantAnalysis Components toolbar 
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8.1 Batch Info Component 

The Batch Info component prints one element from the batch information of the loaded 
batch. A layout can contain several Batch Info components, each of them printing 
different batch information. 

Type: Text 

Button:   

Specific component properties to be defined 
The element to be printed is selected in the Selection tab of the component's Compo-
nent Properties dialog. This tab displays the various items of batch information that 
can be selected. Only a single element is allowed to be selected by checking its corre-
sponding box. Either the Name or the Value (default) of the selected element can be 
printed. 

  
Figure 8-2 Selection tab: Selection of one element for a Batch Info component 
 

8.2 Acquisition Parameter Table Component 

The Acquisition Parameter Table is component prints a table of acquisition para-
meters of the loaded batch. This table contains the parameter names and correspond-
ing values.  

Type: Table 

Button:  
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Selection of acquisition parameters requires an analysis to be selected for the active 
layout. An appropriate analysis can be loaded using the Select Analysis command 
from the QuantAnalysis menu.  
Note: When an Acquisition Parameter Table component is selected and the 

Properties command from the Edit menu is chosen but currently no analysis is 
loaded for the active layout, the Open Analysis dialog will automatically be 
opened to select an analysis. 

Specific component properties to be defined 
By setting the Show N/A Parameter option in the Properties tab of the component's 
Component Properties dialog you can define whether all selected or only the applic-
able parameters are to be printed in the report. This option allows you to use the same 
report layout for different instrument configurations (e.g. different ion sources). When 
this option is not checked, only the applicable parameters that are relevant for the 
respective analysis will be printed in the report. When this option is checked, not appli-
cable parameters will also be printed getting the value 'n/a'.  
 

  
Figure 8-3 Properties tab for an Acquisition Parameter Table component (default 

setting) 

The parameters to be printed are selected in the corresponding Selection tab. This tab 
displays a selectable subset of all acquisition parameters of the currently loaded ana-
lysis. Multiple selections of elements are allowed. You can select all elements of inter-
est by checking the corresponding boxes. 

How the table should look like is set in the corresponding Table style tab. 
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Figure 8-4 Selection tab: Selections of multiple elements for an Acquisition Parame-

ter Table component 
 

8.3 LC Acquisition Parameter Component 

The LC Acquisition Parameter component prints LC acquisition parameters of the 
loaded batch. The LC acquisition program enters the parameters that correspond to the 
different components of the LC system in the respective analysis folder. 

Type: Multi Line Text 

Button:   

Specific component properties to be defined 
The LC acquisition parameters to be printed are selected in the Table columns tab of 
the component's Component Properties dialog. This tab lists all columns currently 
defined for the component. For a newly inserted component, the column list will be 
empty.  
To add a column to this list, click  and select the desired item from the appearing 
list. Repeat adding for all columns you want to have in the report. Use  and  to 
change the columns' sequence in the list and, therefore, in the report. Click  to 
delete a column from this list. 
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Figure 8-5 Table columns tab: Selection of columns for a LC Acquisition Parameter 

component 

 
Figure 8-6 List of LC acquisition parameter items available 
 

8.4 Method Parameter Component 

The Method Parameter component prints one element from the general quantitation 
method parameters of the loaded batch.  

Type: Text 

Button:  

Specific component properties to be defined 
The element to be printed is selected in the Selection tab of the component's Compo-
nent Properties dialog. This tab displays the general method parameters that can be 
selected. Only a single element is allowed to be selected by checking the correspond-
ing box. Either the Name or the Value (default) of the selected element can be printed. 
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Figure 8-7 Selection tab: Selection of one element for a Method Parameter compo-

nent 
 

8.5 Method Table Component 

The Method Table component prints quantitation method data of the loaded batch.  

Type: Table 

Button:  

Specific component properties to be defined 
The method parameter columns to be printed are selected in the Table columns tab of 
the component's Component Properties dialog. For a newly inserted component, the 
column list will be empty.  
To add a column to this list, click  and select the desired item from the appearing 
item list. Repeat adding for all columns you want to have in the report. Use  and  
to change the columns' sequence in the list and, therefore, in the report. Click  to 
delete a column from this list. 

How the table should look like is set in the corresponding Table style tab. 
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Figure 8-8 Table columns tab: Selection of columns for a Method Table component 

  
Figure 8-9 List of method items available 
 

8.6 Work Table Component 

The Work Table component prints the Work Table of the loaded batch.  
Note: Compound specific columns will only be printed within a Compounds Iterator 

component. 
Type: Table 

Button:  

Specific component properties to be defined 
The Work Table columns to be printed are selected in the Table columns tab of the 
component's Component Properties dialog. For a newly inserted component, the 
column list will be empty. To add a column to this list, click  and select the desired 
item from the appearing item list. Repeat adding for all columns you want to have in the 
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report. Use  and  to change the columns' sequence in the list and, therefore, in 
the report. Click  to delete a column from this list. 

How the table should look like is set in the corresponding Table style tab. 
 

  
Figure 8-10 Table columns tab: Selection of columns for a Work Table component 

  
Figure 8-11 List of Work Table items available 
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8.7 Analyses Iterator Component 

The Analyses Iterator component iterates through all analyses of the loaded batch. All 
layout components that are placed inside an Analyses Iterator component will be 
applied to the analysis that is iterated. Therefore, with one layout several analyses can 
be printed at a time. 

Type: Iterator 

Button:   

Specific component properties to be defined 
How the data to be printed should be arranged in the printout is defined in the Iterator 
tab of the component’s Component Properties dialog. 
 

8.8 Analysis Name Component 

The Analysis Name component prints the name of the current analysis. 
Note: This component will only work within an Analyses Iterator component. 
Type: Text 

Button:   
 

8.9 Analysis Info Component 

The Analysis Info component prints one element from the analysis information of an 
analysis. A layout can contain several Analysis Info components, each of them 
printing different analysis information. 
Note: This component will only work within an Analyses Iterator component. 
Type: Text 

Button:   

Specific component properties to be defined 
The element to be printed is selected in the Selection tab of the component's Compo-
nent Properties dialog. This displays the various items of batch information that can 
be selected. Only a single element is allowed to be selected by checking its corre-
sponding box. Either the Name or Value (default) of the element can be printed. 
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Figure 8-12 Selection tab: Selection of one element for an Analysis Info component 
 

8.10 Chromatogram Component 

The Chromatogram component prints one or more chromatograms of the current ana-
lysis.  
Note: This component will only work within an Analyses Iterator component. 
Type: Graphic 

Button:   

Specific component properties to be defined 
The chromatogram(s) and retention time range to be printed are set in the Properties 
tab of the component's Component Properties dialog.  

  
Figure 8-13 Properties tab for a Chromatogram component (default setting) 
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The Line Width parameter sets the line width in points to be used to print the graphic. 
The Print parameter sets the chromatogram(s) to be printed. If Target Chrom. is 
selected the chromatogram of the target compound will be printed. If Target/ISTD 
Chrom. is selected the chromatogram of the target compound and the chromatogram 
of the ISTD compound will be printed.  
By Start Time [min] and End Time [min] the retention time range to be printed is set. 
If both are zero, the total chromatogram will be printed. 
The Type parameter sets the chromatograms to be printed. If Single Chrom. is 
selected only a single chromatogram will be printed. If Multiple Chrom. is selected all 
chromatograms of a batch will be printed.  
Note: The Single Chrom. option will only work within a chromatogram iterator. 

Whether the height of the graphic should be adjusted to page height is defined in the 
corresponding Graphic tab. 
 

8.11 Spectrum Component 

The Spectrum component prints one or more mass spectra of the current analysis. 
Note: This component will only work within an Analyses Iterator component. 
Type: Graphic 

Button:   

Specific component properties to be defined 
The mass spectrum/spectra and mass range to be printed are set in the Properties tab 
of the component's Component Properties dialog.  

The Line Width parameter sets the line width in points to be used to print the graphic. 
The Print parameter sets, which mass spectrum/spectra should be printed. If Target 
Spectrum is selected the mass spectrum of the target compound will be printed. If 
Target/ISTD Spectrum is selected the spectrum of the target compound and the 
spectrum of the ISTD compound will be printed.  
By Start Mass and End Mass the mass range to be printed is set. If both are zero, the 
total mass spectrum will be printed. 

Whether the height of the graphic should be adjusted to page height is defined in the 
corresponding Graphic tab. 
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Figure 8-14 Properties tab for a Spectrum component (default setting) 
 

8.12 Compounds Iterator Component 

The Compounds Iterator component iterates through all compounds of the loaded 
batch. All layout components that are placed inside a Compounds Iterator component 
will be applied to the compound that is iterated. Therefore, with one layout several 
compounds can be printed at a time. 

Type: Iterator 

Button:  

Specific component properties to be defined 
How the data to be printed should be arranged in the printout is defined in the Iterator 
tab of the component’s Component Properties dialog. 
 

8.13 Compound Name Component 

The Compound Name component prints the name of the current compound. 
Note: This component will only work within a Compounds Iterator component. 
Type: Text 

Button:  
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8.14 Compound List Component 

The Compound List component prints the Compound List of the current analysis.  
Note: This component will only work within an Analyses Iterator component. 
Type: Table 

Button:  

Specific component properties to be defined 
The columns to be printed are selected in the Table columns tab of the component's 
Component Properties dialog. This tab lists all columns currently defined for the 
component. For a newly inserted component, the column list will be empty.  

  
Figure 8-15 Table columns tab: Selection of columns for a Compound List component 

To add a column to this list, click  and select the desired item from the appearing list 
(same as for DataAnalysis Compound List layout). Repeat adding for all columns you 
want to have in the report. Use  and  to change the columns' sequence in the list 
and, therefore, in the report. Click  to delete a column from this list. 

How the table should look like is set in the corresponding Table style tab. 
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Figure 8-16 List of Compound List items available 
 

8.15 Calibration Blocks Iterator Component 

The Calibration Blocks Iterator component iterates through all calibration blocks of 
the loaded batch. All layout components that are placed inside a Calibration Blocks 
Iterator component will be applied to the calibration block that is iterated. Therefore, 
with one layout several calibration blocks can be printed at a time. 

Type: Iterator 

Button:  

Specific component properties to be defined 
How the data to be printed should be arranged in the printout is defined in the Iterator 
tab of the component’s Component Properties dialog. 
 

8.16 Calibration Curve Component 

The Calibration Curve component prints the calibration curve of the current com-
pound. 
Note: This component will only work within a Compounds Iterator component. 
Note: It is also useful to use a Calibration Blocks Iterator component to iterate 

through the calibration blocks. 
Type: Graphic 

Button:  

Specific component properties to be defined 
Whether the height of the graphic should be adjusted to page height is defined in the 
corresponding Graphic tab. 
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8.17 Calibration Block Number Component 

The Calibration Block Number component prints the number of the current calibration 
block. 
Note: This component will only work within a Calibration Blocks Iterator component. 
Type: Text 

Button:  
 

8.18 Audit Trail Component 

The Audit trail component prints the audit trail of the loaded batch.  

Type: Table 

Button:   

Specific component properties to be defined 
The columns to be printed are selected in the Table columns tab of the component's 
Component Properties dialog.  
This tab lists all columns currently defined for the component. For a newly inserted 
component, the column list will be empty. To add a column to this list, click  and 
select the desired item from the appearing list (same as for DataAnalysis Compound 
List layout). Repeat adding for all columns you want to have in the report. Use  and 

 to change the columns' sequence in the list and, therefore, in the report. Click  
to delete a column from this list. 

How the table should look like is set in the corresponding Table style tab. 
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Figure 8-17 Table columns tab: Selection of columns for an Audit Trail component 

 
Figure 8-18 List of Audit Trail items available 
 

8.19 Signer Table Component 

The Signer Table component prints detailed signing information.  

Type: Table 

Button:   

Specific component properties to be defined 
The columns to be printed are selected in the Table columns tab of the component's 
Component Properties dialog.  

The Signer Table items available are the same as described above for the DataAnaly-
sis Signer Table component (see section 7.25). 
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8.20 Signer List Component 

The Signer List component prints the names of all signers in succession. It is intended 
for placing signing information into the header or footer. 

Type: Text 

Button:   
 

8.21 Application Name Component 

The Application Name component prints the application name and version number. 
For example, for Bruker Compass applications ‘Bruker Compass’ is placed in front, e.g. 
‘Bruker Compass QuantAnalysis 2.0’. 

Type: Text 

Button:   
 

8.22 QuantAnalysis Menu and Select Analysis 
Command 

The Select Analysis command is used to load the analysis you want to use to select 
the acquisition parameters for an Acquisition Parameter Table component. 

 
Figure 8-19 QuantAnalysis menu 

On selecting this command, the Open Analysis dialog appears which allows you to 
select the analysis whose acquisition parameters you want to see in the corresponding 
Selection tab of the Component Properties dialog. This dialog is the same as 
described in section 7.2. 
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8.23 Saving Folder for QuantAnalysis Layouts 

QuantAnalysis layouts must be saved to the folder "C:\BDALSystemData\Report 
Layouts\QuantAnalysis". Only layouts that are contained in the QuantAnalysis folder 
will be listed in QuantAnalysis' Print dialog. 

Depending on the current installation, the QuantAnalysis folder contains (an) instru-
ment-specific sub-folder(s), e.g. "…\\QuantAnalysis\Esquire" in which you can save 
your layouts. In addition, you can create own sub-folders. When saved to such a sub-
folder, a layout will be listed in the QuantAnalysis Print dialog with the sub-folder name 
followed by the layout name e.g., ‘Esquire\QuantAnalysis Summary Report’. 
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9 FLEXANALYSIS-SPECIFIC FEATURES 

When flexAnalysis is installed on your system, ReportDesigner provides flexAnalysis-
specific features to design layouts for printing reports with flexAnalysis. The flexAna-
lysis Components toolbar contains buttons for inserting flexAnalysis components in 
the layout: this toolbar is only shown when ReportDesigner has been started without 
opening a specified layout or a flexAnalysis layout is active.  
ReportDesigner provides the following flexAnalysis-specific components for printing 
reports with flexAnalysis. 

  

View  
Spectrum  
Legend  
Mass List  
File Info  
Spectrum Parameter  
Spectrum Parameter Table  
Spectra Iterator  
Analyses Iterator  

Figure 9-1 flexAnalysis Components toolbar 
 

9.1 View Component 

The View component prints the current display of the Mass Spectrum window.  
Type: Graphic  

Button:   

Specific component properties to be defined 
In the Properties tab of the component's Component Properties dialog is defined 
whether the Mass Spectrum window should be printed with its current size.  
If Fit view to frame is checked, the Mass Spectrum window will be printed with its 
current size and scaled to the frame of the View component. If this option is not 
checked, the Mass Spectrum window will be printed with the size of the View com-
ponent’s frame. 
Whether the height of the graphic should be adjusted to page height is defined in the 
corresponding Graphic tab. 
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Figure 9-2 Properties tab for a View component (default setting) 
 

9.2 Spectrum Component 

The Spectrum component prints one or more mass spectra. Only spectra that are 
enabled in the Analysis List will be printed. 
Note: Printing does not depend on the current display of the Mass Spectrum window. 
Type: Graphic 

Button:   
 
The Spectrum component behaves different depending on the respective iterator(s) it 
is placed in: 
• No iterator: All enabled spectra are printed together within the frame of the Spectrum 

component displayed according to the setting of the View parameter (see below). 
This results in one spectrum displaying graphic being printed that contains one or 
several spectra. If more than one mass spectrum is enabled, the Draw Labels and 
Draw Peaks options (see below) apply only to the last processed spectrum.  

• Spectra Iterator (w/o Analyses Iterator): All enabled spectra of the last loaded 
analysis are printed as single graphics one beneath the other within the frame of the 
Spectra Iterator component. This results in several spectrum displaying graphics (n 
= number of spectra) are being printed, each of them containing a single spectrum. 
The Draw Labels and Draw Peaks options (see below) apply to each spectrum. 

• Analyses Iterator (w/o Spectra Iterator): All enabled spectra of a particular analysis 
are printed together within the frame of the Spectrum component displayed accord-
ng to the setting of the View parameter (see below). And the respective graphics of 
all analyses are printed one beneath the other within the frame of the Analyses 
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Iterator component. This results in several spectrum displaying graphics (n = number 
of analyses) are being printed, each of them containing one or several spectra. The 
Draw Labels and Draw Peaks options (see below) apply only to the last processed 
spectrum. 

• Analyses Iterator with Spectra Iterator: All enabled spectra of a particular analysis 
are printed as single graphics one beneath the other within the frame of the Spectra 
Iterator component. Moreover, the respective graphics of all analyses are printed 
one beneath the other within the frame of the Analyses Iterator component. This 
results in several spectrum displaying graphics (n1 + n2 + … + nx = number of 
spectra analysis 1 + number of spectra analysis 2 + … + number of spectra analysis 
x) are being printed, each of them containing a single spectrum. The Draw Labels 
and Draw Peaks options (see below) apply to each spectrum. 

 
Specific component properties to be defined 
In the Properties tab of the component's Component Properties dialog is defined 
how (a) mass spectrum/spectra should be printed. 
The View parameter sets if multiple spectra that will be printed together in one graphic 
should be printed in Overlaid, in Stacked or in List display. 
The Draw Labels option sets whether or not labels (m/z values) should be drawn. If 
this option is checked and the Spectrum component is not placed inside a Spectra 
Iterator component, only the labels of the last processed of multiple enabled spectra 
will be printed. If the Spectrum component is placed inside a Spectra Iterator compo-
nent, each spectrum will be printed with labels. If this option is not checked, no labels 
will be drawn. 
The Draw Peaks option sets whether or not peaks should be drawn. If this option is 
checked and the Spectrum component is not placed inside a Spectra Iterator compo-
jnent, only the peaks of the last processed of multiple enabled spectra will be drawn. If 
the Spectrum component is placed inside a Spectra Iterator component, for each 
spectrum peaks will be drawn. If this option is not checked, no peaks will be drawn. 
The Range X parameter sets which mass range is to be printed. If Total is set, the total 
mass range will be printed. If Use Settings is set, the mass range that should be 
printed has to be specified in Min. Mass [m/z] and Max. Mass [m/z]. Min. Mass [m/z] 
sets the lowest mass and Max. Mass [m/z] the highest mass to be printed. 
The Range Y parameter sets which intensity range is to be printed. If Total is set, the 
total intensity range will be printed. If Use Settings is set, the intensity range that 
should be printed has to be specified in Min. Intensity and Max. Intensity. Min. Inten-
sity sets the lowest intensity and Max. Intensity the highest intensity to be printed. 

Whether the height of the graphic should be adjusted to page height is defined in the 
corresponding Graphic tab. 
 



flexAnalysis-Specific Features Bruker Daltonik GmbH 

 ReportDesigner Reference Manual, Version 4.5 9-4 

 
Figure 9-3 Properties tab for a Spectrum component (default setting) 
 

9.3 Legend Component 

The Legend component prints a legend concerning the mass spectrum/spectra that 
should be displayed by the Spectrum component to which the Legend component is 
assigned. 

Type: Graphic 

Button:   

Specific component properties to be defined 
Whether the height of the graphic should be adjusted to page height is defined in the 
Graphic tab of the component's Component Properties dialog. 
 

9.4 Mass List Component 

The Mass List component prints the Mass List of a mass spectrum, which was found 
by performing the Find Peaks operation.  

Type: Table 

Button:  

Concerning the iterators available the Mass List component behaves the same as 
described for the Spectrum component. If more than one mass spectrum is enabled 
and the Mass List component is not placed inside a Spectra Iterator component, only 
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the Mass List of the last processed spectrum will be printed. Thus, the printed Mass 
List always corresponds to the labels and peaks displayed provided that the Draw 
Labels and Draw Peaks options of the Spectrum component are set. If the Mass List 
component is placed inside a Spectra Iterator component, the Mass List of each 
spectrum will be printed. 
 
Specific component properties to be defined 
How the printed Mass List should look like is defined in the Properties tab of the 
component's Component Properties dialog. 
The Get layout from flexAnalysis option sets whether the columns to be printed 
should be taken over from flexAnalysis or be defined in ReportDesigner. If this option is 
checked, that Mass List Layout will be used that is currently defined for the respective 
analysis in flexAnalysis when printing of the report is started. If this option is not 
checked, the columns to be printed have to be defined in the corresponding Table 
columns tab. 
The Print Peak parameter sets, which peaks should be included in the printed Mass 
List. If All is selected, all peaks currently contained in the Mass List will be printed. If 
No. of peaks is selected, the number of peaks specified in No. of peaks will be printed 
at the most. If the Mass List contains more peaks than should be printed, the peaks 
that will be included in the printed Mass List depend on the current sorting of the Mass 
List. In each case, the respective uppermost peaks of the sorted list will be taken. 
How peaks should be sorted is defined by the Get sorting from flexAnalysis, Sort 
type and Set order parameters.  
If the Get sorting from flexAnalysis option is checked, peaks will be sorted the same 
as currently sorted in the Mass List window when printing of the report is started. If this 
option is not checked, peaks will be sorted according to the sort criterion selected in 
Sort Type. 
The Sort type parameter sets the sort criterion to be used with the following criteria 
being available: Background Peak Flag, Relative Intensity [%], Chi Square, Good-
ness, Area, Resolution, Signal to Noise, Full width at half height, Intensity, m/z. 
The Set order parameter sets if the peaks should be sorted in Ascending or 
Descending order. 
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Figure 9-4 Properties tab for a Mass List component (default setting) 

If Get layout from flexAnalysis is not checked, the columns to be printed have to be 
defined in the corresponding Table columns tab. This tab lists all columns currently 
defined for the component. For a newly inserted component, the column list will be 
empty.  
To add a column to this list, click  and select the desired item from the appearing list 
(same as for flexAnalysis Mass List layout). Repeat this for all columns you want to 
have in the report. Use  and  to change the columns' sequence in the list and, 
therefore, in the report. Click  to delete a column from this list. 

How the table should look like is set in the corresponding Table style tab. 
 

 
Figure 9-5 Table columns tab: Selection of columns for a Mass List component if 

columns should not be taken over from flexAnalysis 
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Figure 9-6 List of Mass List items available (same as for flexAnalysis Mass List lay-

out) 
 

9.5 File Info Component 

The File Info component prints one element from the file information of an analysis. A 
layout can contain several File Info components, each of them printing different file 
information. 

Type: Text 

Button:   

Specific component properties to be defined 
The element to be printed is selected in the Selection tab of the component's Compo-
nent Properties dialog. This tab displays the various items of the file information that 
can be selected. Only a single element is allowed to be selected by checking its 
corresponding box. Either the Name or the Value of the selected element can be 
printed. 
 

 
Figure 9-7 Selection tab: Selection of one element for a File Info component 
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9.6 Spectrum Parameter Component 

The Spectrum Parameter component prints one item from the spectrum parameter 
saved with a mass spectrum. The spectrum parameters include acquisition as well as 
processing parameters.  

Type: Text 

Button:  

Specific component properties to be defined 
The element to be printed is selected in the Selection tab of the component's Compo-
nent Properties dialog. This tab displays a selectable subset of spectrum parameters 
that might be available. Only one single element is allowed to be selected by checking 
the corresponding box. Either the Name or Value of the element can be printed. 

 
Figure 9-8 Selection tab: Selection of one element for a Spectrum Parameter compo-

nent 
 

9.7 Spectrum Parameter Table Component 

The Spectrum Parameter Table component prints a table of spectrum parameters 
saved with a mass spectrum. This table contains the parameter names and corre-
sponding values. The spectrum parameters include acquisition as well as processing 
parameters. 

Type: Table 

Button:   
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Specific component properties to be defined 
In the Properties tab of the component's Component Properties dialog can be 
defined whether all selected or only the applicable spectrum parameters should be 
printed in the report.  
If Show not avail. parameters is set, also the names of the selected, but on the 
respective spectrum not applicable parameters will be printed. This allows you to use 
the same report layout for different instrument configurations. If this option is not 
checked, only the applicable parameters that are relevant for the respective spectrum 
will be printed. 
 

 
Figure 9-9 Properties tab for a Spectrum Parameter Table component (default set-

ting) 

The parameters to be printed are selected in the corresponding Selection tab. This tab 
displays a selectable subset of all spectrum parameters that might be available. Multi-
ple selections of elements are allowed. You can select all elements of interest by 
checking the corresponding boxes. 

How the table should look like is set in the corresponding Table style tab. 
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Figure 9-10 Selection tab: Selection of multiple elements for a Spectrum Parameter 

Table component 
 

9.8 Spectra Iterator Component 

The Spectra Iterator component iterates through all enabled mass spectra. All layout 
components that are placed inside a Spectra Iterator component will be applied to 
each spectrum that is iterated. Therefore, with one layout several spectra can be 
printed at a time.  
Type: Iterator 

Button:  

Specific component properties to be defined 
How the data to be printed should be arranged in the printout is defined in the Iterator 
tab of the component’s Component Properties dialog. 
 

9.9 Analyses Iterator Component 

The Analysis Iterator component iterates through all analyses currently open in flex-
Analysis. All layout components that are placed inside an Analyses Iterator compo-
nent will be applied to the analysis that is iterated. Therefore, with one layout several 
analyses can be printed at a time. 
Type: Iterator 

Button:   
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Specific component properties to be defined 
How the data to be printed should be arranged in the printout is defined in the Iterator 
tab of the component’s Component Properties dialog. 
 

9.10 Saving Folder for flexAnalysis Layouts 

To be listed in flexAnalysis' Print dialog, flexAnalysis layouts have to be saved to an 
established folder. Normally, this will be "D:\Methods\Report Layouts\FlexAnalysis". 
Note: The Report Layout files are installed in a folder named Report Layouts, which is 

located in the flexAnalysis methods directory. If the location for flexAnalysis 
methods is not already established - e.g. due to an installation of flexControl - 
the user is prompted for the location of the methods directory during the flex-
Analysis setup procedure. The default value for the methods directory is 
"D:\Methods". 
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10 PROFILEANALYSIS-SPECIFIC FEATURES 

When ProfileAnalysis is installed on your system, ReportDesigner provides ProfileAna-
lysis-specific features to design layouts for printing reports with ProfileAnalysis. The 
ProfileAnalysis Components toolbar contains buttons for inserting ProfileAnalysis 
components in the layout; this toolbar is only shown when ReportDesigner has been 
started without opening a specified layout or a ProfileAnalysis layout is active. 

ReportDesigner provides the following ProfileAnalysis-specific components for printing 
reports with ProfileAnalysis.  

  

Project Name 
Sample Table  
Models Iterator  
Model Name  
Bucketing Parameter  
Number of PC  
Explained Variances Plot  
Hotelling's T2 Plot  
Influence Plot  
Scores Plot  
Loadings Plot  
Analyses Iterator  
Analysis Name  
Scores Overview Plot  
Excluded Buckets  

 

Figure 10-1 ProfileAnalysis Components toolbar 
 

10.1 Project Name Component 

The Project Name component prints the name of the current project.  

Type: Text 

Button:   
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10.2 Sample Table Component 

The Sample Table component prints the sample table of the current project. 

Type: Table 

Button:   

Specific component properties to be defined 
How the table should look like is set in the corresponding Table style tab. 
 

10.3 Models Iterator Component 

The Models Iterator component iterates through all models of a project. All layout 
components that are placed inside a Models Iterator component will be applied to the 
model that is iterated. Therefore, with one layout several models can be printed at a 
time. 

Type: Iterator 

Button:   

Specific component properties to be defined 
How the data to be printed should be arranged in the printout is defined in the Iterator 
tab of the component’s Component Properties dialog. 
 

10.4 Model Name Component 

The Model Name component prints the name of the current model.  

Note: This component will only work within a Models Iterator component. 
 
Type: Text 

Button:   
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10.5 Bucketing Parameter Component 

The Bucketing Table component prints the bucketing parameters of the current 
model. 

Note: This component will only work within a Models Iterator component. 

Type: Table 

Button:   

How the table should look like is set in the corresponding Table style tab. 
 

10.6 Number of PC Component 

The Number of PC component prints the number of the current PC.  

Note: This component will only work within a Models Iterator component. 

Type: Text 

Button:   

 

10.7 Explained Variances Plot Component 

The Explained Variances Plot component prints the explained variances plot of the 
current model. 

Note: This component will only work within a Models Iterator component. 

Type: Graphic 

Button:   

Specific component properties to be defined 
Whether the height of the graphic should be adjusted to page height is defined in the 
Graphic tab of the component's Component Properties dialog. 
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10.8 Hotelling's T2 Plot Component 

The Hotelling's T2 Plot component prints the Hotelling's T2 plot of the current model. 

Note: This component will only work within a Models Iterator component. 

Type: Graphic 

Button:   

Specific component properties to be defined 
Whether the height of the graphic should be adjusted to page height is defined in the 
Graphic tab of the component's Component Properties dialog. 
 

10.9 Influence Plot Component 

The Influence Plot component prints the influence plot of the current model. 

Note: This component will only work within a Models Iterator component. 

Type: Graphic 

Button:   

Specific component properties to be defined 
Whether the height of the graphic should be adjusted to page height is defined in the 
Graphic tab of the component's Component Properties dialog. 
 

10.10 Scores Plot Component 

The Scores Plot component prints a Scores plot of the current model.  

Note: This component will only work within a Models Iterator component. 

Type: Graphic 

Button:   

Specific component properties to be defined 
The two PCs to be plotted in the scores plot are selected in the Properties tab of the 
component's Component Properties dialog. 
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The Get PC numbers from ProfileAnalysis option sets whether the current both PCs 
selected in ProfileAnalysis or two specified PCs are to be plotted. If this option is 
checked the current Scores plot displayed in ProfileAnalysis will be printed. If this 
option is not checked the Scores plot for the two PCs defined by the 1st PC number 
and 2nd PC number parameters will be printed.  
 

 
Figure 10-2 Properties tab for a Scores Plot component (default setting) 

Whether the height of the graphic should be adjusted to page height is defined in the 
Graphic tab of the component's Component Properties dialog. 
 

10.11 Loadings Plot Component 

The Loadings Plot component prints a Loadings plot of the current model. 

Note: This component will only work within a Models Iterator component. 
 
Type: Graphic 

Button:   

Specific component properties to be defined 
The two PCs to be plotted in the loadings plot are selected in the Properties tab of the 
component's Component Properties dialog. 
The Get PC numbers from ProfileAnalysis option sets whether the current both PCs 
selected in ProfileAnalysis or two specified PCs are to be plotted. If this option is 
checked the current Loadings plot displayed in ProfileAnalysis will be printed. If this 
option is not checked the Loadings plot for the two PCs defined by the 1st PC number 
and 2nd PC number parameters will be printed.  
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Figure 10-3 Properties tab for a Loadings Plot component (default setting) 

Whether the height of the graphic should be adjusted to page height is defined in the 
Graphic tab of the component's Component Properties dialog. 
 

10.12 Analyses Iterator Component 

The Analyses Iterator component iterates through all analyses of a project. All layout 
components that are placed inside an Analyses Iterator component will be applied to 
the analysis that is iterated. Therefore, with one layout several analyses can be printed 
at a time. 

Note: This component will only work within a Models Iterator component. 
 
Type: Iterator 

Button:   

Specific component properties to be defined 
How the data to be printed should be arranged in the printout is defined in the Iterator 
tab of the component’s Component Properties dialog. 
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10.13 Analysis Name Component 

The Analysis Name component prints the name of the current analysis.  

Note: This component will only work within an Analyses Iterator component. 

Type: Text 

Button:   
 

10.14 Scores Overview Plot Component 

The Scores Overview Plot component prints the scores overview plot of the current 
analysis. 

Note: This component will only work within an Analyses Iterator component. 

Type: Graphic 

Button:   

Specific component properties to be defined 
Whether the height of the graphic should be adjusted to page height is defined in the 
Graphic tab of the component's Component Properties dialog. 
 

10.15 Excluded Buckets Component 

The Excluded Buckets component prints the excluded buckets of the current model. 
Note: This component will only work within a Models Iterator component. 

Type: Text 

Button:   
 

10.16 Saving Folder for ProfileAnalysis Layouts 

ProfileAnalysis layouts must be saved to "C:\BDALSystemData\Report Layouts\Profile-
Analysis". Only layouts that are contained in the ProfileAnalysis folder will be listed in 
ProfileAnalysis' Print dialog.  
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11 AUDITTRAILVIEWER-SPECIFIC 
FEATURES 

When AuditTrailViewer is installed on your system, ReportDesigner provides AuditTrail-
Viewer-specific features to design layouts for printing reports with AuditTrailViewer. 
The AuditTrailViewer Components toolbar contains buttons for inserting AuditTrail-
Viewer components in the layout; this toolbar is only shown when ReportDesigner has 
been started without opening a specified layout or an AuditTrailViewer layout is active. 
ReportDesigner provides the following AuditTrailViewer-specific components for 
printing reports with AuditTrailViewer.  

  

Entires Table  
Record Description  
Filter Description  
Sort Description  
Application Name  

 

Figure 11-1 AuditTrailViewer Components toolbar 
 

11.1 Entries Table Componen 

The Entries Table component prints the entries of the open audit trail that are currently 
contained in the Entries table. 
Type: Table 

Button:   

How the table should look like is set in the corresponding Table style tab. 
 

11.2 Record Description Component 

The Record Description component prints the record description of the open audit 
trail. For an electronic record the corresponding file name and path is given. The 
system and the UserManagement audit trials are indicated by 'System Audit' and 
'UserManagement Audit', respectively. 
Type: Text 

Button:   
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11.3 Filter Description Component 

The Filter Description component prints the description of the filter that is used to filter 
the entries of open audit trail. 

Type: Text 

Button:   

11.4 Sort Description Component 

The Sort Description component prints the description of the sort mode that is used to 
sort the entries of open audit trail. 

Type: Text 

Button:   

11.5 Application Name Component 

The Application Name component prints the application name and version number. 
Bruker Daltonics applications have the name ‘Bruker Daltonics’ placed in front e.g. 
‘Bruker Daltonics AuditTrailViewer 4.2’. 

Type: Text 

Button:   

11.6 Saving Folder for AuditTrailViewer Layouts 

It is recommended to save AuditTrailViewer layouts in "C:\BDALSystemData\Report 
Layouts\AuditTrailViewer". This folder is opened by default when selecting the Audit-
TrailViewer's Print > Configure Report command found in its File menu. 
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